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Before You Begin… 

Background Info 

n fall of 2008, UBC embarked on a review of the Consolidated Budget Process and conducted 

in-depth interviews with the executive, administrative staff, faculty finance officers, faculty 

staff representatives and departmental staff about their concerns with the current budget process 

and software/system. It was identified that the existing processes and systems including budgeting 

and management reporting did not meet the needs of the campus community.  

The objective of this project is to implement new university wide budgeting processes and systems 

that meet Budget Office as well faculty and departmental requirements. The implementation phase 

began in mid-November 2009 and is expected to run until October 2010, in time for the 2011/12 

budget cycle starting in October 2010.  

. 

Other References 

This tutorial guides you through some of the features of the Budgeting System.  However, complete 

details can be found in the Campus-Wide Budgeting System User Manual. 

 

Stay up to date with the goings on of the Titan/Atlas Project by visiting this website regularly -   

http://www.it.ubc.ca/projects/strategicprojects/titanatlas.html 

 

You are always welcome to send e-mail to the team, at budget@finance.ubc.ca  

 

 

 

I 

http://www.it.ubc.ca/projects/strategicprojects/titanatlas.html
mailto:budget@finance.ubc.ca
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Getting to Know the Campus-

Wide Budgeting System 

What will you learn in this lesson? 

 Some of the most important concepts that define the data you see and work with. 

 A few technical concepts to help you get acquainted with the system itself. 

 The high level view of the end-to-end process. 

 How to launch the Campus-Wide Budgeting System. 

 How to navigate through the Budgeting System‟s workspace. 

 Manipulate the workspace “real estate”. 

 Open the application called “Planning”. 

 Working with Scenarios and Versions; what they mean to your planning exercise. 

 

First Thing’s First – Understanding how 
the System Works 

SOME BASIC CONCEPTS 

Dimensions 

Dimensions are structural elements of an application that describe and hold data. Dimensions 

provide perspective on the data being analysed. The main dimensions used for Planning at UBC are 

Scenario, Version, Account, Entity, Year, Period, Project Grant, Fund and Program Code. 

Dimensions and combinations of dimensions define a Point of View. 
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Dimensions represent categories of data. For example, when you enter budget data in a plan you 

must identify what item you are budgeting. Budget items such as travel expenses and salary 

expenses are in Account dimensions. You must also identify the time period for each item. Time 

items such as current quarter and next quarter are in the Period dimension. 

 

Scenario and Version Dimensions 

You can use the scenario and version dimensions to create individual plans that can be reviewed 

and approved. For each entity, the scenario and version combination contains its own set of data for 

accounts and for other dimensions. 

After entering entity data for scenarios and version you can submit or promote the data to other 

users for review and approval. The intersection of entity, scenario and version is referred to as a 

Planning Unit. 

Working with scenarios enables you to group data and to place each data group in a separate plan 

with its own review cycle. Scenario describes the type of plan data (such as budget, actual or 

forecast) and the time span that the plan covers. For example, your organization might require a 

one-year revenue plan and a three-year revenue plan. The plans might be prepared by different 

users and follow different review paths. For this purpose, the unit’s administrator can create two 

scenarios – Current-Year Revenue and 3-Year Forecast. 

Scenarios are assigned start and end years and periods. You can enter data into data forms only for 

scenarios that are within the start and end range specified by your administrator. The scenarios used 

in the Campus-Wide Budgeting system are: ―Plan‖, ―Forecast‖, ―Long Range Forecast‖ and 

―Actuals (ACT)‖ 

Access rights to scenarios are assigned by your administrator. If you do not have access to a 

scenario, you cannot enter data on a data form for that scenario. 

Versions allow for flexibility and iterative planning cycles. For examples, your application can 

have 4 versions – ―define‖, ―approve‖, ―working‖, and ―draft‖. 

At any given time there are several combinations of Scenario and Version accessible to users.  For 

example, at the end of Q2, FY10 (September 2009) the following combinations are available: 

 FY08 FY09 FY10 FY11 FY12 FY12 FY13 

Actuals Approved Approved Approved - - - - 

Plan - - Approved Working - - - 

Forecast - - Working - - - - 

Long Range 
Forecast 

- - Working Working Working Working Working 
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Account Dimensions 

This dimension specifies the FMS account for which data is to be entered budget planners. 

Examples of accounts are ―Sales and Services (add account #)‖ and ―Travel (add account #)‖. (Add 

hyperlink to Hyperion / FMS accounts – not yet available). 

 

PG Dimensions 

This dimension specifies PG from FMS. PGs are generally in the following format 12Z12345. 

 

Entity Dimensions 

This dimension specifies the organizational structure. The main structure is based on the FMS 

AllDeptids Tree.  Alternate structures are also available (e.g. by campus).  Because account codes 

and department codes in FMS are in the same format and sometimes overlap, the departments in 

Hyperion have been prefixed with a ―D‖, e.g. D321000. 

 

Year Dimensions 

This dimension specifies the fiscal year for which data is to be collected from budget planners. 

Examples of Year are FY10, FY11. 

 

Period Dimensions 

This dimension specifies the month for which the data to be collected from budget planners. 

Examples of Period are April, May. 

 

Fund Dimensions 

This dimension specifies Fund for which the data is to be collected from budget planners. Examples 

of Funds are G0000, R3554. 

 

Program Code Dimensions 

This dimension specifies the Program Code for which the data is to be collected from budget 

planners. 
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Members 

The elements that compose a dimension are called members. Members are discrete components 

that, in combination with other members, form a dimension. For example, UBCO and UBCV are 

members of the Entity dimension. 

Data is entered at the base-level of the member, not the upper-level member of the dimension. In 

other words, you can enter data in the lowest level child member. All parent-level members are 

read-only. See the Genealogical Relationships section for more details. 

A dimension may have multiple members. Some of those members can have their own ―child‖ 

members. The values of the parent-level members are aggregated from the values of their children. 

 

Genealogical Relationships 

The entire system functions on the parent and child relationship and the point of view premise. The 

members of a dimension are arranged into hierarchies. 

Members that have members under them are known as ―parent‖ members. The members 

immediately below a member are the children of the member that is directly above them. Members 

that have the same parent are known as ―siblings‖. 

 

 

Points of View 

A point of view (POV) defines the context of the data. A POV defines what data will be retrieved 

from the database and displayed on the data form. A POV is made up of intersecting data elements, 

such as Department, PG and Program Code, to give context to the data. 

 
FIGURE 1:  The combination of the selected data elements (dimensions) gives context to the data on the page. 
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Examples of points of view: 

 Example 1    Example 2 

Scenario Act  Scenario Plan 

Version Approved  Version Working 

Fiscal Year FY09  Fiscal Year FY11 

Period Apr, May, Jun  Period QTR2 

Department D321000  Department Faculty of Arts 

 

Users select the dimensions that will make up the point of view for the selected data form to work 

with. 

For more information on POVs, refer to the Campus-Wide Budgeting System User Manual. 

 

SOME TECHNICAL CONCEPTS 

Elements of Data Forms 

You use data forms to enter data. The elements on the data form enable you to navigate the form 

and to select and enter data. You may enter or edit data only when your system user profile has the 

security privileges, as set by the unit’s systems administrator. 
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Use of Colours 

The systems administrator sets up data forms to show certain dimensions and members, reflected 

by the row, column headings and Point of View. Cells display the data for the selected members. 

Background colors indicate: 

TABLE 1:  There is special significance to the colour of the cells on the data form. 

COLOUR INDICATION 

Pale Yellow Default, database value 

Highlighted Yellow ―dirty‖ cells, whose values changed but are not yet saved 

Light green read-only cells 

Tan locked cells 

Teal cells having supporting detail 

 

Data Forms 

Data forms are spreadsheet-like grids with rows and columns into which data can be entered. They 

reside inside folders. When you select a folder a list of data forms is displayed in the view pane and 

in the content area. 

From the list of data forms, open a data form by selecting it from the content area or the View pane. 
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Business Rules 

Business rules can be launched directly from Planning or they can be associated with data forms. 

Users who have data-entry privileges on a data form can see and launch only the business rules to 

which they have access (based on security settings of user profile), regardless of the number of 

business rules attached to the selected data form. Some business rules launch automatically while 

others prompt the user for input when they are launched. 

NOTE:  Some business rules must be run in a certain order. For example, if launching both a 

currency conversion business rule and a sub-total business rule, the currency conversion business 

rule must be launched before the sub-total rule. 

 

Working with Multiple Applications 

You can open several applications simultaneously — or the same application multiple times — and 

navigate among them by clicking their names on the tabs at the bottom of the content area window.  
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10,000-foot View of the End-to-End 
Process 

Every user of the system will use this system in different ways and for different purposes but all for 

the common goal of defining, refining and managing the university’s budget. 

The following process flow illustrates the high level view of the overall process of working with 

the system. 

 

Of course, once inside the system we go from the 10,000-foot view to the more granular activities. 

Some of those activities include, but are not limited to: 

 Viewing data 

 Updating data 

 Running business rules 

 Transferring funds from one unit to 
another 

 Request approvals 

 Create budget plans 

 Set forecasts 

 Update plans 

 Record funding changes 

 Consolidate data by portfolio 

 Set system preferences 

 View task lists 

 Attach supporting documents 

 Etc.
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This tutorial covers only a very small exemplar of what we can do in the CWBS. The Campus-

Wide Budget System User Manual is a complete reference guide to the system’s features. 

 

Exercise 2-1 – Launching the Campus-
Wide Budgeting System 

Every UBC staff member authorised to work in the Campus-Wide Budgeting System (CWBS) has 

access to the system via the UBC Portal (CWL). 

Any user wishing to work in the Campus-Wide Budgeting System must first log in to CWL (For 

training see #2 below).  Once logged in, click the link to the Campus Wide Budgeting System in 

the Management Systems portal. 

 

 

Scenario:  It’s quite simple really!  You can’t use the Campus-Wide Budgeting System without launching it 

(to start it up, in other words)! 

Prerequisite:  You must be authorized to use it and you must have your own valid user id and password. 
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1. Open Internet Explorer. NOTE:  You must allow pop-ups and if asked 

for access to your clipboard, click Yes. 

2. For the purposes of training, type in the following URL:  

 http://digby.adm.ubc.ca:19000/workspace/index.jsp.   

3. Press the Enter key. The portal‟s Home Page opens. 

4. Enter your user name and login from the Training Login Sheet 

5. The Budgeting System‟s Home page opens. 

 

FIGURE 2: Users‟ Home page may be different for every user depending on individual user settings. 

 



http://digby.adm.ubc.ca:19000/workspace
http://thames.adm.ubc.ca:19000/workspace/index.jsp
http://thames.adm.ubc.ca:19000/workspace/index.jsp
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Exercise 2-2 – Opening a Planning 
Application 

In the Planning component all data is processed inside applications. An application is a related set 

of dimensions and members that meet a specific set of analytic or reporting requirements. 

Scenario:  Opening the planning applications (UBC has two applications; UBCPlan and FundPlan). 

Prerequisite:  You must be logged into the system. 

1. From the Home Page, click the Applications link. 

 

2. Click the UBCPlan application. This opens the budgeting workspace. 

 

 

 





14   /   Chapter 2 - Getting to Know the Budgeting System 

Exercise 2-3 – Navigating the Content 
Area (workspace) 

Use the View Pane on the page's left side to view folders and data forms. To open a data form, 

double-click a folder name, and click a data form's name. The data form opens in the content area 

on the page's right side. 

 
 

The window also provides several tools for selecting tasks and documents: 

 Planning menus 

 Planning toolbars 

 The View Pane 

 

Scenario:  You may want to move around inside the application to see how things work, to get to know it a 

bit before using it. 

Prerequisite:  The Campus-Wide Budgeting System must be running.  That’s it! 

1. In the view pane, click the Forms folder, and then the 2.  Plan folder. 
Open the data form General Expense Input Demo – Plan2. The selected data 
form opens up in the content area. 

2. The workspace is that large window that takes up most of the screen. 

3. The area on the left of the workspace is the View Pane.  

 


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FIGURE 3:  Familiarise yourself with the different elements of the workspace. 

4. To make more room for your work, you have a few options - 

o To hide or show the View Pane at the page's left side, click View and then View 

Pane. 

o Click on the View Pane or Content Area Adjuster. 

o Click, hold and drag the view pane to resize it. 

o Click on the upper-right corner to maximize or minimize the content area. 

How you navigate depends on whether you have just clicked in a cell or are editing the contents of 

a cell. For example, when you click in a cell, you can press the Right Arrow key to move to the 

next cell in the row. When you are editing data in a cell, press the Tab key to move to the next cell 

or click inside the cell with your mouse. 

5. When clicking in a cell and not entering or editing cell data, to move: 

o Forward, backward, up, or down, press the Right Arrow, Left Arrow, Up Arrow, 
or Down Arrow key. 

o To the next cell in the column, press Enter. 

o To the previous cell in the column, press Shift + Enter. 



16   /   Chapter 2 - Getting to Know the Budgeting System 

 

6. When entering or editing data in cells, to move: 

o Forward or backward within the cell data, press the Left Arrow key or the Right 
Arrow key. 

o To the next cell in the row, press Tab or click in the next cell. 

o To the previous cell in the row, press Shift + Tab. 

o To the next cell in the column, press Enter. 

o To the previous cell in the column, press Shift + Enter. 
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Exercise 2-4 – Collapsing and Expanding 
Data Entry Areas and Forms 

You can expand data forms and the data entry area—including the view pane—in several ways. 

 

Scenario:  You may want to move around inside the application to see how things work, to get to know it a 

bit before using it. 

Prerequisite:  The Campus-Wide Budgeting System must be running.  That’s it!  

1. Open the Data Form General Expense Input Demo – Plan2. 

2. Take an action: 

 To resize: Click the View Pane's right border, hold and drag to resize it. 

 To expand or collapse the View Pane: Click View and then View 

Pane, or click, hold and drag the view pane to resize it. 

 To hide or show the view pane: Click  in the screen's upper-right corner. This button is 
directly above the vertical scroll bar at the very right of the window. 

 


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Exercise 2-5 – Selecting the Dimensions 
to Work With 

From a form, you can see the dimensions available for selection in the page view, change the drop 

down selections as required and plan a PG.  Certain dimensions will be predefined in certain forms 

and modifications are not allowed (in the example below only 4 of the dimensions can be modified) 

 

 

Scenario:  Open the form “General Expense Input Demo –Plan2” and navigate to the PG you’ve been 

assigned for Training (00GTRAIN) in the DeptID on your Training Login Sheet. 

Prerequisite:  You must be logged in with your assigned training ID. 

1. Log into Hyperion. 

2. From the CWBS Home Page, open the UBCPlan application. 

 

3. Open the Plan folder. 


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4. Open the form General Expense Input Demo – Plan2. Click Yes when the message appears 
about the file being very large and could take considerable time to load. 

 

5. Use the available drop-down menus to select the dimension included on your Training Login 
Sheet. 

DIMENSION DATA TO SELECT 

Fund G0000 

Department (your assigned department as per the Training Login Sheet) 

PG 00GTRAIN 
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Program Code PC_DEFAULT 

 

6. Click Go. This loads the Planning form for the Point of View specified. 

 

 

What you’ve done and what it all means 

This chapter showed you some of the key architectural concepts that give this system its power, 

how to start the CWBS application and how to move around some of its components.  Don’t be 

afraid to try navigating around the system on your own; see what happens.  The worse that could 

happen is that an option may not become available from your current location. When you feel 

confident, explore the following chapters. 

 

 

Summary 

 The entire system is governed by a security architecture whereby every user‟s profile 
restricts what he/she can do in the system. 

 The CWBS interacts with other university systems, e.g. RISe, Position Management, 
Viking, Student Information System, etc. The CWBS pulls data from these external systems 
for financial planning purposes. 

 Dimensions, otherwise known as „categories‟ describe and hold data. Dimensions are used 
to define the context to the data entered and displayed, e.g. Project Grant, Fiscal Year, 
Faculty, etc. 

 Scenarios group data and place it in separate plans with their own review cycles, e.g. Budget, 
Plan, Actuals. 

 Versions are iterative planning cycles, e.g. Working, Approved, Draft, etc. 

 Members are lower level elements of a dimension that hold the data. Members may contain 
other members. 

 Data can be entered only in the lowest member level of the hierarchy. 

 A Point of View is the combination of a Scenario, Version, Fiscal Year, Department, and 
Project Grant.  
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 Data is always entered on a Data Form. 

 Data forms reside inside the Forms folder. 

 The Forms folder is accessed from the navigation View Pane. 

 Some data forms can have associated business rules. 

 A user role defines what that user can do inside the system, e.g. update data, run a business 
rule, run reports, approve a plan, etc. 
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Planning and Forecasting 

What will you learn in this lesson? 

 How to create your initial plan. 

 How to update your forecast. 

 How to set a long-range forecast. 

 

Exercise 3-1 – Creating a Plan 

Scenario:  It is the beginning of November 2009. The Budget Office wants all departments to create their 

financial plan for the fiscal year 2010/2011. 

Prerequisite:  The Plan has been seeded by the Budget Office and you must have the proper user 

privileges. 

1. From the left navigation View Pane in the application workspace click 

Forms and then Plan. The system displays all the data forms available under 

Plan. 
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2. Select the appropriate data form from the list. E.g. General  Expense Input Demo –  Plan2 .  
The system opens the selected data form in Edit mode if you are authorized to make 
changes to the data therein. To know whether you can edit data on the form, some of the 
fields will be a pale yellow. 

3. Select the appropriate dimensions, e.g. Fund, Unit, PG, Program Code. Only members to 
whom you have access appear in the drop-down menus.  Once the selections are made, 

click the Go button. 

WARNING:  It is imperative you take the time to ensure all dimensions are correct. Every time you 

access this page, the system always defaults to the dimensions selected during your last session, and 

thus, may not specify the correct dimensions for your new, current session. 

 

4. Drill down the list of accounts and until you reach the member (category) of the item for 
which you want to enter data, e.g. “Salaries/Staff Salaries/541000”. 

5. Locate the account to edit and select the cell for January. 

6. Enter an amount in that cell, e.g. “1000” and press Enter. At this stage you can use simple 
data entry or some of the tools presented above. 
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7. Click the Save button ( ). This updates the database with your budget change. 

8. Drill down the list of accounts and until you reach the member (category) of the item for 
which you want to enter data, e.g. “Salaries/Staff Salaries/543000”. 

9. Locate the account to edit and select the cell for December. 

10. Enter an amount in that cell, e.g. “2000” and press Enter. 
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11. By clicking the Refresh button ( ). The system presents a message about unsaved data. 
Accept the change to continue. The form will refresh with the latest version of the 
database. 

 
FIGURE 4:  Notice how the $1000 remains after the Refresh but the removal of the $2000 is reflected in the form. 
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Exercise 3-2 – Updating your Forecast 
(self study) 

Scenario:  The fiscal year has now begun and new information is available to you. You may now update 

your forecast for the current year. 

Prerequisite:  The University’s Plan has been approved by the Board and loaded as the starting point for 

your forecast. 

1. From the left navigation View Pane click Forms and then Forecast. 

The system displays all the data forms available under Forecast.  

2. Select the appropriate forecast data form from the list. E.g. General 
Expense Input  –  Fcst .  The system opens the selected data form in Edit 
mode if you are authorized to make changes to the data therein. To know 

whether you can edit data on the form, some of the fields will be yellow. NOTE:  Notice 
how in the Forecast, the form is Read-Only for the closed months. 

 
FIGURE 5:  Notice the Points of View are the same as chosen in the previous exercise of Creating Plan. Notice also the 
closed and open cells. 

3. Drill down through the list until you reach the “Cost of Sales”, and account “490201 COS – 
General Books”.  

4. Click inside the November cell and enter “20000” and press Enter. 

5. Click in another cell or press the Tab key to move to the next cell. The system changes the 
colour of the edited cell to a highlighted yellow. Continue to make any and all changes 
required. 


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6. Click the Save toolbar button ( ) to save the changes when finished making all your 
changes. Once the changes are saved to the database the cell highlighting is removed. 

 

Exercise 3-3 – Setting a Long-Range 
Forecast (self study) 

Scenario:  You must forecast your unit’s financial plan for the next 3 years. 

Prerequisite:  None. 

1. From the left navigation View Pane click Forms and then Long Range 

Forecast. The system displays all the data forms available under Long Range 
Forecast. 

2. Select the appropriate forecast data form from the list. E.g. General 
Expense Input  –  LRF . The system opens the selected data form in Edit 

mode if you are authorized to make changes to the data therein. To know whether you can 
edit data on the form, some of the fields will be a pale yellow.  

3. By default the system displays columns of forecasts to be entered by fiscal year. To enter 
detailed long range forecast amounts at a more granular level, such as monthly, expand the 

fiscal year‟s column by clicking the little  sign inside the column‟s heading. 

 
FIGURE 6:  Notice how FY10 is Read-Only because the 1st year of the LRF is being populated by the current year 
forecast. 

4. Scroll through the list until you reach the account of the item for which you want to edit 
data.  

5. Locate the account to edit and select the period, or month, to change.  

 


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Exercise 3-4 – Planning by Using a 
System Function 

In addition to Grid Spread, the system provides additional built-in functionality to make the 

planning process more efficient and to make the information more useful.  Refer to Appendix B for 

a list of available options. 

 

Scenario:  You continue making adjustments to your budget using the various system options. 

Prerequisite:  Open the form General Expense Input Demo – Plan2 and ensure you select the proper 

dimension members related to your training ID. 

1. Adjust Feature 

a. Scroll through the list of accounts and expand the “Building 
Operations - Utilities” account. 

b. Select the cell at the intersection of “April” and account “764000 
– IT Rental – Telephone Equipment” under “Building Operations – Utilities / 

Communications”.  

c. Click the Adjust button ( ). This opens a small window on the Data Form. 


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d. Select the “Increase by” radio button and then enter “1500” (percentage is also 
available). This represents $1,500. Do not enter the dollar sign ($) or the comma; just 
the number. 

e. Click the Adjust Data button.  The new value is “5,497”. 

 

f. Click Save ( ). 

 

2. Cut, Copy Paste Features  
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a. Remain at the same intersection (the one with the data). 

b. Click the Copy button ( ). If the system asks you about allowing access to the 

clipboard, say Allow Access. 

c. Select the remaining months for account “764000” by clicking the first cell and 
dragging the mouse to the last cell you want as the complete selection, e.g. from May to 
March. 

d. Click the Paste button ( ). The remaining months have changed to “5497” and the 
system calculates the total for the year as “$65967”. 

 

e. Click Save ( ). 

3. Cell Text Feature 

a. Select the intersection for “TotalYear” and account “764000”. 

b. Click the Cell Text ( ) button. This opens the Cell Text window. 
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c. Enter an explanation as to why you increased the Plan. 

d. Click Submit. A flag now appears in the top right corner of the cell to indicate there is 
text associated with the cell. 

 

e. Click Save ( ). 

4. Add / Edit Document Feature 

a. Click in the “March” cell for the same account “764000”. 

b. Click the Add/Edit Document button ( ). This opens the Add/Edit Document 
dialog window. 

 

c. Click the browse button ( ). The system opens the Select window. 
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d. Select the file “Getting Started with Sample Content.htm” if it is there. If not is at the 
root, continue searching through the folders to find any sort of document file. 

e. Click the OK button in the Select window or double-click the document file name. This 
closes the Select window, inserts the filename of the selected document into the 
Add/Edit Document window. 

f. Click the Submit button in the Add/Edit Document window. This closes the window 
and inserts a small flag in the top right hand corner of the cell. NOTE:  The window 
with the submit button may have been minimized when you clicked the “browse” 
button. 

 

5. To view the attached document, click on the cell, click the Edit menu and then the Open 

Document sub-menu option. The system opens the attached document onto the screen. 

6. Supporting Detail 

a. Scroll down to the “Travel Expenses”, then drill down to “Conferences Expenses”. 
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b. Select the intersection of “July” and “624000 – Conferences - Accommodation”. 

c. Click the Supporting Detail button ( ). This opens the Supporting Detail window. 

d. Add the title “NHL Awards” in the awaiting textbox that says “Untitled”. 

e. Click the Add Child button. This inserts a new blank row (with the text “Untitled” 
directly below the row with the text “NHL Awards”.  

f. Enter the attendee name “Henrik Sedin” in the row that says “Untitled”. This creates 
the genealogical hierarchy of the parent (NHL Awards) and the child (Henrik Sedin). 

 

g. Click the Add Sibling button (to the immediate right of the Add Child button. This 
inserts a new blank row, with the default text of “Untitled”, at the same hierarchical 
level as Henrik Sedin. 

h. Enter the attendee name “Daniel Sedin”. Henrik Sedin and Daniel Sedin are now 
siblings under the parent “NHL Awards”. 

i. Enter the rate of “1500” for each individual. Enter just the number, no dollar sign nor 
separating comma. 
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j. Click in the cell “NHL Awards” and then click Add Sibling. This adds a new row 
under Daniel Sedin, but at the parent level. 

k. Enter “Nights” in place of the text “Untitled”. 
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l. Change the operator to multiply (“ * ”). 

 

m. Enter “2” (for 2 nights) and then click Save. You are returned to the cell with the new 
total of $6000. The cell is highlighted in teal to indicate that the cell has supporting 
details. 
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Exercise 3-5 – Spreading Data Using Grid 
Spread 

Grid Spread automatically distributes amounts from summary Members to level 0 Members based 

on selected criteria.  You can use the Grid Spread option to specify an amount or a percentage by 

which the system increases or decreases values across multiple members.  The spread is based on 

the target cell values. 

When you run a Grid Spread action, the Data Form grid is loaded with the changed values. You can 

view and validate results before saving the data. 

 

Scenario:  You are generally satisfied with the professional expenses in the plan; however you would like to 

reduce them by 2% in FY11. 

Prerequisite:  None. 
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1. Open the form General Expense Input Demo – Plan2. 

2. Expand the “Professional Fees” account and then select the member 
“713000 - Professional Fees”. 

3. Select the cell with the total expenses “TotalYear”. WARNING:  The 
selected cell must contain a value. 

4. Click on the Grid Spread icon ( ). This opens the Grid Spread window. 

 

5. Select “By Percentage” from the Adjust Data drop-down list. 

6. Select the “Decrease by” radio button and enter “2” in the adjoining amount field. 

7. Select “Proportional Spread” from the Spread Type options. 

 

8. Click the Adjust button to see the impact.  The system changes the amount in the Spread 

Value field.   

9. Click the Spread button. This changes the affected cells in the Data Form. 

10. Click Close when finished and then save. 


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FIGURE 7:  Although we did “Proportional Spread” we obtained the same result as we would have if we‟d applied “Even 
Split” because the numbers were the same in each cell before we started this exercise. 

 

Exercise 3-6 – Adjusting Totals Using 
Grid Spread 

1. Stay on the same page as in the previous exercise. 

2. Using simple data entry you learned in Chapter 3, enter the following: 

 

ACCOUNT MONTH AMOUNT 

711000 April 300 

713100 July 250 

714000 October 75 

715000 February 100 


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3. Click Save when done. 

4. Click inside the cell at the intersection of “Professional Fees” and “TotalYear”. 

 
FIGURE 8:  The circle in the diagram illustrates the intersection of “Professional Fees” and “TotalYear”. 

5. Click the Grid Spread button ( ). This opens the Grid Spread window. 

6. From the Adjust Data drop-down list, select “By value”. 

7. Select the “Increase By” radio button. 

8. Enter 3000 in the accompanying data entry field and then click Adjust. 
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9. Click Spread.  The system calculates the new values. 

10. Close the Grid Spread window to return to the Data Form. Notice the changed data. 

11. Click Save when done. Notice that the total was updated. 

 

 

What you’ve done and what it all means 

 You‟ve learned to enter data into data forms 

 You‟ve learned how to spread an amount across multiple cells for the same account. 

 You‟ve also learned how to use the system-delivered options to assist with budget 
preparation.  
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Business Rules (Self-Study) 

What will you learn in this lesson? 

 How to view what business rules are available on a form. 

 How to run a business rule. 

 

Exercise 4-1 – Identifying the Business 
Rules Available to the Data Form (self 
study) 

Scenario:  You would like to apply seasonality to your budget by reflecting the seasonality that existed in 

the prior year. 

Prerequisite:  You must be in the form that contains the business rule. To know whether the form has a 

business rule, look in the left navigation view pane – There’s the list of folders, then the list of all the data 

forms in the selected folder, and then the business rules attached to the selected data form are listed in the last 

place in that view pane. 



48   /   Chapter 4 – Business Rules 

 
 

1.  From the same form, General  Expense  Input Demo –  Plan2,  
right-click on the PG drop-down list. A sub-menu appears and displays some 
menu options. 

 

2. From the drop-down list click on 2. Apply Historical Seasonality. This opens the Runtime 
Prompts window. 


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3. Select a member for each dimension when prompted. NOTE:  Some of these dimensions will 
be different for every user because of the training IDs assigned to you. 

a. Account: click on the magnifying glass icon, expand “STMT_REV_EXP”  and place a 
checkmark in the “expenses” checkbox.  

b. Click the arrow to move “expenses” to the Selected Members pane (Alternatively you 
could type “Expenses”). 

Click Submit. The Member Selection for Account window closes and adds 
“Expenses”to the Select Account text field. 

 

4. Repeat Step 3 for each dimension in the window. 
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Dimension Value to select 

Year to base seasonality on FY09 

Periods to base seasonality on Select all the months 

Scenario to base the seasonality on Act 

Version to base seasonality on Approved 

Year to populate FY11 

Scenario to populate Plan 

Version to populate Working 

 

5. Click Validate. NOTE:  If you see the system message “One or more runtime prompt values 
are invalid…” look to see where the problem is (likely the field with the red X (e.g. “Scenario to 
populate”)) and correct it. 

6. For the missing Scenario to populate, select “Plan”, and then click Validate again. 

7. Click Launch. A Launch Successful dialog box appears. Data now has a seasonal trend. 

 

 

What you’ve done and what it all means 

You’ve learned to launch a business rule to apply historical figures to an upcoming plan. 
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Transfers 

What will you learn in this lesson? 

 How to execute a GPO funding transfer. 

 How to accept and reject transfers. 

 

Exercise 5-1 – Transferring GPO Funding 
to another Unit 

Scenario:  You want to transfer funding from PG 00GTRAIN from your DeptID DYYYYYY to DeptID 

DXXXXXX. (where DYYYYYY and DXXXXXX = the training IDs on your Training Login Sheet.) 

Prerequisite:  You must have the authority to execute GPOF Funding transfers, as well as the applicable 

user privileges. 

1. Click the Home Page tab in the bottom left-hand corner of the page. 

2. Click the Applications link on the Home Page. 

3. Click the FundPlan option. This opens the FundPlan application and 
lists the folders and data forms applicable to Funding. 

4. Select the “GPO External Transfers” folder from the View Pane. 
The data forms associated with the GPO external transfers are listed in the content 
area on the right. 


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5. Select the form “1.00 Pending GPO External Transfers Out”. This opens a list of your total 
pending transfers by department (you have only one department for training, and you‟re 
starting with a blank slate). 

6. Ensure your department (as per the Training Login Sheet), PG 00GTRAIN and 2009/10 are 

selected in the drop-downs and then click Go. 

 

7. Right-click on the text “Line_Itemxx”.   The system displays a mini menu.  

8. Click Initiate Transfer from the pop-up menu. This opens the Initiate Transfer window. 
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9. Enter the data in the corresponding text fields on the Initiate Transfer window. NOTE:  Be 
sure to expand the window to see all the fields and the scrollbar and do not change any of the 
data in the fields marked with “Do not change”. 

Text Field Data to Enter 

Enter a description for this transfer Request for funds for Geography 

Select the Department to Transfer to X_D121600 (the DeptID indicated in 

column ―Transfer Funds To‖ on your 

Training User ID sheet  

Enter the amount to transfer in the first 

year 

10500 

Enter amount to transfer on a recurring 

basis 

15000 (Note, when the recurring transfer is 

$0, leave #MISSING in the field) 

Enter contact information for this transfer Dean’s Office 2-2252 

Select Period in which the transfer will 

occur 

Apr 

10. Click the Validate button. If you entered all the information correctly, the system displays a 
message saying that all runtime prompts are valid. 
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11.  Click the Execute button to execute the transfer you specified. As long as there are no errors, 
the system will list the new transfer record on the page. 

 

FIGURE 9:  The system lists both transfers you just executed. 
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Exercise 5-2 – Accepting / Rejecting GPO 
Funding Transfer 

Scenario:  Funds are being transferred to your department for a special project you will be managing.  

Review the list of pending transfers and accept the funding. 

Prerequisite:  A funding transfer to your PG has been executed by another PG.  (Always right-click on the 

top, left hand field) 

1. Click Forms in the navigation View Pane. It‟ll display all the associated 
funding-related data folders and forms. 

2. Select the GPO External Transfers folder. 

3. Open the form 2.00 Pending External Transfers In. This form shows the 
transfers pending for all the departments you have access to.  (You have access 

to two departments in this training module) 

 

4. Right-click on your assigned department. By right-clicking the line with the pending transfer, a 
small pop-up menu appears.  


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5. Click Review sending Dept detail. This page lists the total pending transfers for your 
department and separated by department. 

6. Right-click on “Budget Office”. This is the transfer you want to review.  Another small pop-up 
menu appears. 

 

7. Click Review Line Item detail. This list displays all the pending transfers from the Budget 
Office to your department. In this example, we see only one pending transfer. 



Campus-Wide Budgeting System Tutorial   /   59 

Contact Information 

budget@finance.ubc.ca 

http://www.it.ubc.ca/projects/strategicprojects/titanatlas.html 

 

 

 

8. Right-click the pending transfer (e.g.LINE_ITEM02) and then click Review Transfer 

detail.  

 

9. Right-click on “No Project Grant” and then click Approve Transfer. This will open the 
Approve Transfer  window where you can approve or reject the transfer and assign a PG. 
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10. In the Approve Transfer window, enter “00GTRAIN” in the field “Select Project Grant to 

Transfer to” and then click Validate. The system displays the message that all runtime prompt 
values are valid. 

 

11. Click Execute. The transfer is approved. 
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What you’ve done and what it all means 

So far, the big picture looks like this: 

 You‟ve transferred and received GPO Funding. 

 You‟ve seen your list of Pending Transfers 
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Workflow 

What will you learn in this lesson? 

 How to verify the status of the Plan 

 How to submit your the departmental Plan for review 

 How to promote the Plan as a reviewer 

 

The Planning Unit 

Planning tracks the budget by planning unit. A planning unit is a slice of data at the intersection of 

a scenario (Budget, Plan, Actuals), a version (Working, Approved, Draft) and an entity (Faculty of 

Arts, Faculty of Medicine, General Administration). It is the basic unit for preparing, annotating, 

reviewing, and approving plan data. At UBC workflow is enabled for all departments for Scenario 

= Plan and Version = Working. 

A planning unit is always in one of six states. See the following table 

State Description 

Not Started The initial state of all planning units.  The budget administrator initiates the 

review process using the Start action. 

First Pass The first state for planning units selected to go through the Workflow 

process.  There is no owner of a planning unit during First Pass.  Any user 

with data access can enter data and promote the planning unit during the 

―First Pass‖ state. 

Under Review This state occurs when a Promote action is taken on a planning unit and 

signifies that a planning unit is being reviewed by someone in the 

organization.  Only the current owner or the budget administrator can 

modify data or perform an action on a planning unit that is in the ―Under 

Review‖ state. 

Signed Off This state occurs when a Sign Off action is taken on a planning unit.  Only 
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the current owner or the budget administrator can modify data or perform an 

action on a planning unit that is in a ―Signed Off‖ state.  Ownership does not 

change when a planning unit is signed off. 

Not Signed Off This state occurs when a Reject action is taken on a planning unit.  Only the 

current owner or the budget administrator can modify data or perform an 

action on a planning unit that is in a ―Not Signed Off‖ state. 

Approved This state occurs when an Approve action is taken on a planning unit.  After 

a planning unit is approved, the budget administrator becomes the owner of 

the planning unit.  Only the budget administrator can modify data or perform 

an action on a planning unit that is in an ―Approved‖ state.  After all the 

planning units are approved, the budgeting cycle is complete. 

NOTE: In all states except the ―Not Started‖ state, users with read access 

can view data, view the process state, view the history, and read and enter 

new annotations. 

 

 

Exercise 6-1 – Viewing the Status of a 
Planning Unit 

Scenario:  You are a Planner or Reviewer and you want to see if a Planning Unit you are responsible for 

has been submitted. 

Prerequisite:  None. 

1. From the main menu click File > Workflow > Manage Process. 

 

2. The Process Definition page appears.  

3. From the Scenario drop-down list, select “Plan”. 


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4. From the Version drop-down list, select “Working” and then click Go. The system displays a 
list of planning units to which you have access.  

5. For your Planning Unit, click the Details link (your Planning Unit or DeptID is listed on the 
Training Login sheet). 

 

6. Click Details to see information about a planning unit. 
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Exercise 6-2 – Submitting a Plan 

Scenario:  You’ve completed the planning for your Department and are ready to submit to the department’s 

Reviewer. 

Prerequisite:  All PG budgets within the unit have been completed. 

1. From the main menu, click File > Workflow > Manage Process. 

2. Select the correct Scenario (“Plan”) and Version (“Working”) you would 

like to submit and then click Go. The system displays the list of planning units. 

3. For the department you‟ve been working in, click the Details link. This 
displays the status and annotations of the currently selected planning unit. 

 

4. Click the Change Status button. This causes the Change Status window to open. 

5. From the Select Action drop-down list, select “Promote”.  From the Select Next Owner drop-
down list select the reviewer on the Training Login Sheet e.g. TRAINxx 

6. Click the Submit button when finished. The Change Status window closes and returns you to 
the Planning Unit Status and Annotation window where the system updates the status of the 
review process and any annotations. 

7. Click the Done button in the bottom right-hand corner of the window when finished. The 
system closes the Planning Unit Status and Annotation window and returns to the Process 
Definition window. 

 

 

 

 


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Exercise 6-3 – Reviewing / Approving a 
Planning Unit 

Scenario:  You are a reviewer. You have received a Planning Unit from a Preparer, have reviewed the 

details and are now ready to promote the budget to the VP’s office. 

Prerequisite:  You are the owner of a Plan that has been promoted. 

1. From the main menu, click File > Workflow > Manage Process. 

2. Select the correct Scenario and Version you would like to manage (Plan / 

Working) and then click Go. The system displays the list of planning units. You 
see that you are the Current Owner of a Planning Unit under review for a given 
department. 

3. Click Details of the Planning Unit with your name assigned to it. This opens the Planning Unit 
Status and Annotation window. 

4. Click Change Status. The Change Status window opens. 

5. Select “Reject” as your action from the Select Action drop-down list.  

6. Select original planner as the next owner of the planning unit (refer to the Training ID sheet).  

7. Enter an annotation in the large freeform text field. 

8. Click the Submit button when finished. The Change Status window closes and returns you to 
the Planning Unit Status and Annotation window where the system updates the status of the 
review process and any annotations.  

9. Click the Done button in the bottom right-hand corner of the window when finished. The 
system closes the Planning Unit Status and Annotation window and returns to the Process 
Definition window. 

 

 

What you’ve done and what it all means 

You should now understand the workflow of Hyperion’s Planning component. 

 Once you submit your Plan, you can no longer make changes to it. 

 Once the Reviewer approves the plan you can no longer make changes it. 

 You can make changes only when the plan has been rejected. 

 


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The Task List – Your To-Do list 

What will you learn in this lesson? 

 How to view your unit‟s task list. 

 How to complete a task. 

 

What is a Task List? 

Administrators and interactive users can set up task lists that guide you through the steps — 

including their due dates — to complete a budget cycle. For example, a task might help you enter 

data, complete data forms, run a business rule, and submit numbers for approval or promote 

planning units. Tasks can display instructions, due dates, completed dates, and alerts. Your 

administrator can also include tasks that link to other applications. 

 

Exercise 7-1 – Viewing your Unit’s Task 
List 

Scenario:  It is 8:30 in the morning. You want to see whether anyone assigned budgeting or planning tasks 

for you to do. Your task list will let you know. 

Prerequisite:  This procedure works in basic and in advanced modes. 

1. Click View from the main menu, then Basic Mode, and then Task 
List appears in your left navigation View Pane.  


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2. Click the  next to the Task Lists folder to display the list of all task lists to which you 
have access. 

3. Expand the task list to view (“2010-11 (FY11) Plan”) by clicking it from the folders pane. 

4. Expand the 2010-11 (FY11) Plan folder to reveal all awaiting task lists. 

5. Click on the first item. This automatically launches the required document for the selected 
task. 

 

6. Click the Next button to work your way through the tasks. 
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7. Continue to click Next until you‟ve gone through all the tasks. 

8. After completing each task, check the Complete checkbox in the bottom left corner of 

the content area. Upon clicking Complete the task is marked as complete and  is 
displayed next to the task in the view pane.  
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To leave the Task List and return to the UBCPlan application, click View and then 

Advanced Mode. 

 

 

What you’ve done and what it all means 

So far, the big picture looks like this: 

 You have viewed the task list(s) assigned to you. 

 You have viewed a listed task and its instructions, if any. 

 You have indicated that you completed a stated task. 
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Workforce 

What will you learn in this lesson? 

 What information can be planed for positions that are managed in the Position 
Management System 

 How to plan for a position that does not yet exist in the Position Management System 

 How to make high level adjustments to salary and benefits plans 

 

Exercise 8-1 – Viewing the Status of 
Existing Positions 

Scenario:  You want to review the Position Management System’s status for positions within your PG. 

Prerequisite:  You must be in the UBCPlan application and you must have access to the Workforce 

module. 

1.  From the left navigation View Pane click Forms and then 

Workforce. The system displays all the data forms available under 
Workforce. 

2. Select the form 4.00 Existing Position – Status. 

3. You currently have 13 positions, and all of them are “Active”. 

4. This is an informational Data Form. No actions are taken on this form. 

5. To move to the form for Exercise 2, right-click on the position and select Edit Existing 

Position Information (Alternatively, complete steps 1 and 2 of Exercise 2.) 

 


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Exercise 8-2 – Viewing Existing 
Position Information 

This form is also used to plan one-time payments, merit, unfunded salary increases and shift 

differentials.  The cells that can be planned are yellow. 

 

Scenario:  You want to review the salary and benefits expense information loaded to your PG 

(00GTrain) from the Position Management System. 

Prerequisite:  You must be in the UBCPlan application and you must have access to the Workforce 

module. 

1.  From the left navigation View Pane click Forms and then 

Workforce. The system displays all the Data Forms available under 
Workforce. 

2. Select the form 4.01 Existing Position Information. 

 

3. We are still working with the same Plan information.  Ensure your Point of View is set to: 

DIMENSION DATA TO SELECT 

Fund G0000 

Department (your assigned department as per the Training Login Sheet) 

PG 00GTRAIN 
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Program Code PC_DEFAULT 

Fiscal Year 2010/11 

Scenario Plan 

Version Working 

 

4. Once you‟ve made your selections, click Go.  This form displays employee information 
from the Position Management System.  

5. At this stage you would review the employee information to ensure the data coming from 
Position Management is in line with your expectations. 

6. For Henrik Sedin, select the Merit and Other OT column and enter “5000”.  This amount 
will be added to your planned salary expenses for the year.  

 
 

7. Click Save when done.  This exercise ends here. 
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8. We see that Mason Raymond is eligible for Overtime. Right-click on any position and 

select Edit Overtime Hours to plan for overtime. (Alternatively, complete steps 1 and 2 
of Exercise 3). 
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Exercise 8-3 – Planning Overtime for 
the Year 

Scenario:  You’ve noted that Mason Raymond is eligible for overtime and you want to plan the cost 

for the year. 

Prerequisite:  You must be in the UBCPlan application and you must have access to the Workforce 

module. 

1.  From the left navigation View Pane click Forms and then 

Workforce. The system displays all the data forms available under 
Workforce. 

2. Select the form 4.04 Overtime Hours. Only those positions eligible 
for overtime appear.  

3. You expect that all of the overtime will occur in May and June with an estimated duration 
of 10 hours per month. 

4. For Mason Raymond enter “10” in May and “10” in June. The overtime will now be 
included in your plan for FY11. 

 

5. Click Save. This exercise ends here. 

6. Right-click the position and select Edit New Employee Information to move to the 
next phase of planning. (Alternatively, complete steps 1 and 2 of Exercise 4.) 

 


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Exercise 8-4 – Entering New Position 
Information 

Scenario:  You want to plan for the hiring of a new employee for which there is no position in the 

Position Management System. 

Prerequisite:  You must have access to the Workforce module. 

1. From the left navigation View Pane click Forms and then 

Workforce. The system displays all the data forms available under 
Workforce. 

2. Ensure you are in the 4.03 New Position Information Data Form. 

3. Right-click on the fund; from the menu select Add To-be-hired, 

but don‟t click on it yet. You just want to expose the menu. This launches a business 
rule to add and TBH (To be hired) position that will be reflected in your plan. 

 

4. Move your mouse pointer over Add To-be-hired; this opens a sub-menu. Click 

Salary. A business rule has been launched to add a new position for planning 
purposes. 

 


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5. Expand the window to see all the data entry fields and then enter the following fields 

(as per the data in the following image) and then click Validate when you‟re done. 

 

6. Click the Add button, to add the position to the plan. (Click Refresh if you see an 
error.) 
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7. Click Save to save the new position information. This exercise ends here for New 
Position Information. 

8. Right-click the position and select Input Financial Data by Department to move 
to the next phase of planning. (Alternatively, complete steps 1 and 2 of Exercise 5) 

 

 

Exercise 8-5 – Making a high-level 
planning adjustment to salaries or 
benefits 

Scenario:  You are happy with the information from Position Management and you’ve added all the 

new positions you wanted to plan, but, you know that based on the Dean’s plans your current planned 

salaries are too low by about $50,000. 

Prerequisite:  You must have access to the Workforce module. 

1. Ensure you are in the 4.12 Input Financial Data by Department 
Data Form.  All of the GL accounts are read-only (these have been planned 
based on existing positions and new positions). 

2. You can make budget adjustments to any of the following high-
level salary accounts and the amounts will be reflected in your plan: 

 WF_SALFAC (Faculty Salaries) 


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 WF_SALSES (Sessional Salaries) 

 WF_SALSTF (Staff Salaries) 

 WF_SALSTD (Student Salaries) 

 WF_BENEFT (Benefits) 

3. In your estimate the entire $50,000 is related to staff, and you estimate that the related 
benefit rate is 18%. 

4. In the TotalYear column for Account WF_SALSTF enter “50000”. 

5. In the TotalYear column for Account WF_BENEFT enter “9000”. 

6. Click Save. 
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What you’ve done and what it all means 

You should now understand the 3 main components that will contribute to the Salaries and 

Benefits component of your Plan  

 Existing Positions 

 New Positions 

 High-level adjustments 
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Campus-Wide Budgeting System Tutorial  /  91 

Contact Information 

budget@finance.ubc.ca 

http://www.it.ubc.ca/projects/strategicprojects/titanatlas.html 

 

 

Reports 

What will you learn in this lesson? 

 Where to find reports. 

 How to open reports. 

 How to drill down into reports. 

 

Financial Reporting vs. Web Analysis 

Hyperion includes Oracle Hyperion Financial Reporting Fusion Edition and Oracle Hyperion Web 

Analysis reporting capabilities. 

 

FINANCIAL REPORTING 

 Highly formatted financial and operational reporting 

 Multi-dimensional data 

 Web environment 

 

WEB ANALYSIS 

 Web-based interactive reporting against 

 Multi-dimensional data sources 

 Web environment 
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PLANNING DATA SOURCES 

Planning uses the multi-dimensional database Essbase to store dimension hierarchies and 

consolidated data. Once the Essbase database is created for each plan type (e.g. ISPlan) in the 

application (UBCPlan), it contains the dimensions, members, and data values relevant to the plan 

type. 

 

ACCESS TO REPORT CONTENT 

Workspace provides a single point of access to both Financial Reporting and Web Analysis.  

 

Depending on your assigned roles and security access, you can use Workspace to view and print 

reports and books, set preferences, create and schedule batches. You can define preferences and 

formatting options for the Financial Reporting and Web Analysis: 

 Default mode for previewing reports 

 User POV preview, location and member selections 

 Microsoft Office application to which reports are exported 

 Behaviour of prompts 

 Display of the View Pane 

 

BROWSING THE REPOSITORY 

In the Explore module ( ) you can open reports and books, export and import items. When 

you select a repository folder from the View Pane, the folder items to which you have access are 

displayed in the content area. By default, each item displays name, type, date, modified, and 

description. You can sort the list of items by clicking the column headings. 
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INTERACTING WITH WEB ANALYSIS REPORT 

Web Analysis allows users to manipulate data in documents to display specific information. 

Methods of manipulation include changing pages, drilling to different levels of data, changing the 

data displayed, and keeping or removing dimension-specific data. 

Web Analysis provides advanced analytical tools that enable you to perform quick, ad hoc analysis 

of a document. Analysis tools speed up comparisons, visually organize data, and promote 

conclusions.  

You can: 

 Sort data 

 Filter data 

 Search data 

 Define formulas 

 Add Traffic Light 

 Create Pinboards 

 Set User Preferences 
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Exercise 9-1 – Access Web Analysis 
Reports in HTML 

Prerequisite:  You must have adequate user security privileges. 

1. Click the Explore toolbar button ( ). The system opens the list 
of folders that contain the various reports. 

2. Click the Titan Reports folder. 

3. Click the Production folder and then the ISPlan folder. 

4. Right-click the report “Actual Plan and Forecast Comparison”.  This file 
has an extension of “Web Analysis Document”. A sub-menu appears. 

5. Click Open As > HTML.  The system generates the report and displays it in HTML format on 
the screen. The POV is the combination of the most recent filter criteria selections.  

6. Change the POV by interacting with the choices provided. Enter the data as outlined in the 
following table: 

DATA FIELD DATA TO ENTER/SELECT 

Fund G0000 

Department (the one assigned to you on the Training Login Sheet) 

Project Grant 00GTRAIN 

Program Code PC_DEFAULT 

 


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FIGURE 10:  To see the entire report, close the left navigation View Pane. 

7. Select “December” in the list of period on the right and observe the change. 

 
 

These reports are dynamic. Which means you can change the values of the dimensions to change 

the results on the report seen on the screen. 

 

 



96   /   Chapter 9 - Reports 

 

Exercise 9-2 – Interacting with Web 
Analysis Reports 

Prerequisite:  You must have adequate user security privileges. 

1. Navigate to the same report in Exercise 1 Actual Plan and Forecast 
Comparison. 

2. Move your cursor to the Account column and right-click on Expenses 

> Drill > Drill Down. The Expenses account expands to show the next level of 
account members. 

3. Place the cursor on the text “Supplies_Expenses”. 

4. Right-click and select Keep Only. The rest of the accounts would be excluded from the report. 

 
 





Campus-Wide Budgeting System Tutorial  /  97 

Contact Information 

budget@finance.ubc.ca 

http://www.it.ubc.ca/projects/strategicprojects/titanatlas.html 

 

 

 

 

 

Exercise 9-3 – Analysis Tools – Traffic 
Lights 

1. Return to the YearTotal radio button (on the right). 

 

2. Right-click on the account “Supplies_Expenses” (a pop-up menu appears) and select Analysis 

Tools and then Traffic Light…. The Traffic Lighting Control Panel opens. 


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3. Set Points: >= -10000 and >= 10000. See image above. 

4. Click OK.  The system closes the window and returns to the report. Notice the colour changes. 

 
 

Traffic Light Colours 
The colours indicate varying range sets based on the parameter thresholds you set. For 

example, you could define the range as ―0‖ to ―25‖. Green would indicate that the current 

data is somewhere between ―0‖ and ―9‖. Yellow would indicate that the data is between 

―10‖ and ―19‖ and red would be ―20‖ to ―25‖.  

 

Traffic Light Colour Meaning 
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Green Green indicates that all is fine! 

Yellow Yellow indicates that things are still relatively within acceptable 
range but you should monitor things. 

Red Red is an indication that potential problems are on the horizon 
based on the parameters set. 

 

 

Exercise 9-4 – Analysis Tools – 
Calculation (self study) 

1. Stay on the same report (the one with the traffic lights). 

2. Place the cursor on any of “FY09” heading labels, and right-click on 

Analysis Tools.  

 

 

3. Click on Calculation… The Calculation Definition window opens. 

4. Click the Functions tab. 





100   /   Chapter 9 - Reports 

 

5. From the Function drop-down list, select “Average”. 

 

6. From the Select Members pane, highlight “FY09” and “FY10”, click the arrow to move the 
selected members (FY09 and FY10) to the “Arguments” box. Notice that the Formula Box is 
now populated with the combination of Function and Arguments. 
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FIGURE 11:  Once member selections are made, the system creates the formula in the Formula box. 

7. Click the Insert button on the middle right of the screen. The Calculation Definition is now set 
up. 

 

8. Go to the top of the window and enter a name in the Name field: “AVG FY09 FY10”. 
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9. Click OK to complete the formula. The report is now added the Formula column. 

 

 

Exercise 9-5 – Preview Financial 
Reporting Reports in HTML or PDF 

Prerequisite:  You must have adequate user security privileges. 

1. Click the Explore toolbar button ( ). The system opens the list 
of folders that contain the various reports. 

2. Click the Titan Reports folder. 

3. Click the Production folder and then the ISPlan folder. 

4. Right-click the report “Snapshot –Scenarios and Variances” (this file has 
an extension of “Financial Reporting Report”). A sub-menu appears. 

5. Click Open In > HTML Preview. This causes the Preview User Point of View window to 
open. 


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6. Enter the data specified in the following table and then click the OK when defining all your 
dimensions: 

Data Entry Field Data to Enter 

Period TotalYear 

Project Grant 00GTRAIN 

Entity (as defined on the Training Login Sheet) 

Program Code PC_DEFAULT 

Fund G0000 

Year FY10 

7. The reporting component of the system gives you the ability the drill down through reports in 
both HTML and PDF.  Click on the arrows next to the accounts. Hover over the sideways 
arrow. The tooltip says “Expand”.  
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NOTE:   The report can also be opened in PDF by clicking Open In > PDF Preview instead of 

HTML Preview. It may look as though the system is not responding, but just be patient. It is 

working. 

8. On the POV select a different Period, e.g. “Period: Q2”. 

 
FIGURE 12:  Clicking the button opens the Member Selection window. 
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9. Expand the “Period” member and the “YearTotal” member. 

10. Select “Q2” and then click OK to review the report. 

 
FIGURE 13:  See the result of the change of Period from TotalYear to Q2. 
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Exercise 9-6 – Export the Report to Excel 

Prerequisite:  The report must be open on the screen. 

1. Click the File menu. 

2. Click Export. 

3. Click Excel. 

4. Click Fully Formatted Grids and Text. This opens the File 
Download window.  

5. You may choose to first open the file in Excel to view it before saving it by clicking the Open 

button or you may save directly from the window by clicking Save and selecting a storage 
location.  


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Last, But Not Least… 

Logging off of the Campus-Wide 
Budgeting System 

You can quit just the current session or exit the Campus-Wide Budgeting System entirely 

 

Scenario:  You have finished working on the financial plans and reports. You want to now close the system 

session. You must now log off. 

Prerequisite:  You must be logged in to be able to log off, oddly enough! 

1. Click File, then Log Off. 

2. In Log Off, click Yes. The Log On screen is displayed for your next 
session. 

3. To close Planning, click File, then Exit. 

Note: If you log on and do not use the application for awhile, you are automatically 

logged off at the interval your administrator set. 

 

 

Summary of everything you’ve done 

Don’t feel intimidated and don’t be afraid to try things!  There is nothing scary or mysterious about 

the Budgeting System!  It’s just a computer application designed to make your job a little easier 

and more enjoyable. 

Go forth and have fun! 


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Appendix A – Menu items 

Menus 

You have access to only the menus that your user profile permits you to access. For example, users 

who are assigned the role of Administrator can access all functions on the Administration menu 

and users who are assigned the Interactive user role can access some functions on the Administration 

menu. 

 

File Menu 

The following table describes the commands under the File menu. 

New Creates documents, personal pages, workspace pages, data forms, 

reports, task lists, user variables, or menus. 

Open Opens a document, application or URL. 

Close Closes whatever is currently open. 

Save Saves data input to data forms. 

Print Prints the current screen. 

Workflow Manages the Planning process or copy versions. 

Preferences Sets general, authentication, explore, Web analysis, Financial 

Reporting, Planning, and other settings. 

Log off Logs off the application. 

Exit Exits the workspace 

 

Edit Menu 

The following table describes the commands under the Edit menu. 

Adjust Increases or decreases data values by a percentage or by a specific 

value. 

Grid Spread Spreads data values across multiple dimensions on the grid. The 

options are ―proportional‖, ―even split‖ and ―fill‖. 

Launch Rules Launches a business rule from a data form. 

Annotate 

Planning Unit 

Adds comments to a planning unit. 

Cell Text Adds comments to a specific cell or to a range of cells at any level in 

a data form. 
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Supporting 

Detail 

Adds detail that aggregates to the cell value in a data form. 

Lock/Unlock 

Cells 

Locks cells so that they are ignored when data is spread. 

Initialize 

Workforce 

Loads pre-defined dimensions and members, data forms, member 

formulas, business rules and menus to prepare plans for workforce 

resources (members, forms, and business rules can be customized). 

NOTE:  The option ―Initialize Workforce‖ is displayed only if the 

option was selected and configured during the configuration of 

Planning by a systems administrator. 

 

View Menu 

The following table describes the commands under the View menu. 

View Pane Hides or shows the View pane. 

Refresh Refreshes the current view to reflect what is stored in the 

database. 

Instructions Views instructions for a data form. This option is available only 

when the data form contains instructions. 

View and Account 

Annotations 

Enters, edits or views comments for a specific account, entity, 

scenario and version combination. 

Basic Mode Toggles the view for tasks between basic and advanced modes. 

Task List Views task lists to which you have access, views task status, and 

creates a task list report. 

 

Administration Menu 

The following table describes the commands under the Administration menu. 

Manage Data Forms Creates, edits, moves, deletes and assigns access to data 

forms. 

Manage Task Lists Creates, edits, moves, deletes and assigns access to task lists. 

Manage Menus Creates and edits menus. 

Manage User 

Variables 

Specifies the values of variables that are assigned to data 

forms. 

Dimensions Sets and changes access for dimensions such as Account, 

Entity, Scenario and Version and for user-defined dimensions. 
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Copy Data Copies data, including supporting details, from one planning 

unit to another. 

Clear Cell Details Clears the cells of any details contained therein. 

Reporting Prints Planning information including form definitions, user 

and group report lists, access assignments for dimensions, 

planning unit annotations, process status lists, and active 

application auditing. 

View Statistics Views information about the Planning application and its 

usage. 

Application Settings Sets Planning application-wide preferences. 

Business Rule 

Security 

Assigns launch security to business rules. 

Copy Document Link Links tasks in task lists to application pages. 

 

Tools Menu 

Advanced Search Searches the workspace for documents. 

Links Manages links to other products or URLs. 

Business Rules Launches business rules. 
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Appendix B – Toolbar Buttons 

The toolbar buttons provide shortcuts to Planning tasks and open dialog boxes that you can use to 

manage documents, task lists, and favourites. The following table describes the buttons on the 

toolbar. 

Button Tooltip Description 

 
Explore Allows the user to access the root directory.  This directory 

includes the reports. 

 
Save Saves data input on data forms. When you save data the 

totals are recalculated and updated values are displayed for 

members that are calculated dynamically. 

 
Refresh Refreshes the data form with data stored in the database. 

Use this function to update the data on the data form 

without applying any entered or edited values. 

When you refresh data, the system warns you that you 

entered data but did not save. 

 
Print Prints the contents of the currently open screen. 

 
Adjust Increases or decreases values by a percentage or by a value. 

 
Lock/Unlock 

Cells 

Locks or unlocks cells when data is spread. 

 

Grid Spread Spreads data across dimensions on the data form. 

    

 

Cut, Copy, 

Paste 

Cuts, copies or pastes values from one or more cells to one 

or more cells on the data form. 

You cannot paste into read-only cells. 

The system copies and pastes the stored value of the cell, 

not the value determined by the precision setting. 

 

Cell Text Adds comments to a specific cell at any level in data forms. 

 
Add/Edit 

Document 

Adds or edits documents to provide documentation for data 

in cells. 

 
Supporting 

Detail 

Adds detail that aggregates to the cell value in data forms. 

 
Task List Opens task lists – available only if task lists are assigned to 

you. 

 Status Checks task list status. 

 
Log off Logs off the open application. 
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Appendix C – Navigation Shortcuts 

Children of parents can be hidden to navigate the data forms more easily. This feature is especially 

useful for forms that contain large numbers of rows and columns. The following table summarises 

the keys that you can use during data entry. 

Key Result 

Enter Enters a value and moves the cursor to the cell below the current cell. 

Tab Enters a value and moves the cursor to the next cell in the row. 

Shift+Tab Enters a value and moves the cursor to the previous cell in the row. 

Esc Cancels a value and restore the previous value. 

Ctrl+z Cancels a value and restores the previous value. 

Ctrl+c Copies the selected range of cells to the clipboard. 

Ctrl+x Cuts the selected range of cells. 

Ctrl+v Pastes the contents from the clipboard into the current cell. 

 


